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Preface
This user's manual explains the handling precautions, features, and operating procedures of the 
calibration software. To ensure correct use, please read this manual thoroughly before operation.
Keep this manual in a safe place for quick reference in the event that a question arises. 
For details on the handling precautions, features, and operating procedures of the LS3300, 2560A, and 
power meters and the handling and operating procedures of Windows, please refer to the appropriate 
manual.

Notes
•	 The contents of this manual are subject to change without prior notice as a result of continuing 

improvements to the software's performance and functions. The figures given in this manual may 
differ from those that actually appear on your screen.

• 	 Every effort has been made in the preparation of this manual to ensure the accuracy of its contents. 
However, should you have any questions or find any errors, please contact your nearest YOKOGAWA 
dealer.

•	 Copying or reproducing all or any part of the contents of this manual without the permission of 
YOKOGAWA is strictly prohibited.

 

5th Edition: July 2022 (YMI)
All Rights Reserved, Copyright © 2018 Yokogawa Test & Measurement Corporation
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Trademarks
• 	 Microsoft, Internet Explorer, Windows, Windows 8.1, Windows 10, and Windows 11 are either 

registered trademarks or trademarks of Microsoft Corporation in the United States and/or other 
countries.

• 	 Adobe, Acrobat, and PostScript are either registered trademarks or trademarks of Adobe Systems 
incorporated.

• 	 In this manual, the ® and TM symbols do not accompany their respective registered trademark or 
trademark names.

•	 Other company and product names are trademarks or registered trademarks of their respective 
holders.

Disclaimer
Downloading this software indicates your acceptance of the following disclaimer.
•	 YOKOGAWA bears no liability for any problems that may occur during download or installation of this 

software.
• 	 YOKOGAWA assumes no responsibility for any damage that may occur directly or indirectly through 

the use of this software.
•	 This software is offered free of charge, but no unlimited warranties are made against any defects 

whatsoever. Also, YOKOGAWA may not be able to accept inquiries regarding repair of defects in or 
questions about this software.

•	 The property rights, proprietary rights, intellectual property rights, and all other rights associated with 
the software are held by YOKOGAWA.

Revisions
• 	 1st Edition:		 July 2018
•	 2nd Edition:	 September 2018
•	 3rd Edition:	 April 2021
•	 4th Edition:		 June 2021
•	 5th Edition:		 July 2022
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Safety Precautions
For correct use, be sure to read the corresponding manual thoroughly before connecting a device used 
with this software.
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1.	 Overview of This Software

This software automatically calibrates a power meter (WT series) using YOKOGAWA's AC Power 
Calibrator LS3300 or Precision DC Calibrator 2560A.
Load a CSV format file describing calibration points in advance to control the LS3300 or 2560A so that 
reference signals are output according to the calibration points. For the following instruments that can 
be controlled with this software, set the range of the calibration target instrument remotely for each 
calibration point to read the measured values automatically. You can also save a measurement result in 
a report (CSV format file) as a calibration result.

	

Calibration definition file
(Calibration point list)** Calibration result file** Report**

1. Load the 
calibration points

Reference signals

5. Write the measurement result

2. Request the reference signal output

3. Set the measurement 
conditions*

4. Load the measured values*

LS3300/2560A Calibration target (WT series)

Power Meter Calibration Software

*:  For a calibration target other than WT100, WT200, WT300, and WT300E series, you 
cannot automatically set the measurement conditions and load the measured values. 

**: CSV format file (comma-separated)

Calibration Target Instruments
Instruments That Can Be Controlled with This Software
WT310E, WT310EH, WT332E, WT333E
WT310, WT310HC, WT332, WT333
WT200(253421)*2, WT210(760401)*2, WT230(760502, 760503)*2

WT110(253401)*1, *2, WT110E(253451)*2, WT130(253502, 253503)*1, *2

*1:  	 Models with the firmware version 1.11 or later
*2:  	 Can be controlled in the mode compatible with the IEEE488.2 1987 standard (488.2 mode)

Calibration automatically changes the measurement conditions, including the measurement range, 
so the settings for the calibration target instrument are different between before and after calibration. 
To revert to the original settings, you can back up the settings before calibration and reset them after 
calibration.

Instruments That Cannot Be Controlled with This Software
- YOKOGAWA power meters other than the above
- Non-YOKOGAWA power meters
You need to manually set the measurement conditions and read the measured values for the calibration 
target instrument.
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Instrument Configuration
The instrument configuration varies depending on the calibration details.
Calibration details 2560A LS3300
DC Voltage 1 unit

Current 1 unit
Power 2 units

AC Voltage 1 unit
Current (60 A or less) 1 unit
Current (120 A or less) 2 units
Current (180 A or less) 3 units
Power (1P2W), (60 A or less) 1 unit
Power (1P2W), (120 A or less) 2 units
Power (1P2W), (180 A or less) 3 units
Power (3P3W) 2 units
Power (3P4W) 3 units

		

Calibration target 
(WT series)Synchronized 

operation

Remote interface

DC calibration
2560A: Up to 
2 units

AC calibration
LS3300: Up to 
3 units

Remote interface

System Operating Environment
OS (operating system)
	 - Windows 8.1 Update (32-bit/64-bit) Japanese/English
	 - Windows 10 (32-bit/64-bit) Japanese/English
	 - Windows 11 Japanese/English
The latest patch was installed.

.NET Framework

.NET Framework 4.8 (supplied with this software)

CPU
1 GHz or higher processor

Memory
512 MB or more

Storage
HDD available space: 4.6 GB or more

Communication Interface
A communication interface corresponding to the device to connect.
When use GP-IB: 	Environment in which National Instruments GPIB interface driver runs. 
						      Set the GPIB interface ID of the GPIB device on the PC side to GPIB0.

1. Overview of This Software
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2.	 Installation Procedure

Installing USBDriver
Check if YKMUSB, a USB driver for YOKOGAWA products, is installed on your PC.
•	 Windows 8.1, Windows 10 (Device Guard disabled):	 YKMUSB (version 1.0.4.2)
•	 Windows 10 (Device Guard enabled), Windows 11:	 YKMUSB (version 2.0.0.0 and later)
If the driver is not installed, install the appropriate version. If a different version is installed, uninstall it 
first, and then install the appropriate version.
YKMUSB is contained in the file YKMUSBxxxx.zip (where xxxx is the version number) in the folder 
extracted from the compressed file you downloaded.
You can also download the driver from the following web page:
	 https://tmi.yokogawa.com/library/
	 (In the case of Windows 10 (Device Guard enabled), search under Windows 11.

Installing This Software
1.	 Run setup.exe in the folder extracted from the compressed file you downloaded.
	 The installation wizard window appears.

				  

2.	 Click [Next].
	 The license agreement appears.
	 Read the license agreement and check [I accept the terms in the license agreement].
	 Otherwise, check [I do not accept the terms in the license agreement].
	 If you do not accept the terms, the installation is canceled.
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3.	 Click [Next]. The installation confirmation window appears.

				  
4.	 If there is no problem with the installation settings, click [Install].
	 The software is installed.
	 If you click [Back], you will return to the previous screen to change the installation settings.
	 If you click [Cancel], the installation will be canceled.
	 The "User Account Control" window appears in the middle of the installation process. Click 

[Yes].
	 The installation continues.

5.	 When the installation is completed, the completion window appears.
	 Click [Close]. This is the end of installation.

				  

2. Installation Procedure
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Uninstallation Procedure
1.	 Select [Control Panel] on the start window.

2.	 Double-click [Programs and Features].

3.	 Click [Calibration Software].

4.	 Click [Uninstall].

5.	 When the confirmation message appears, click [Yes].

File Structure
This software is installed in the Calibration Software folder in Program Files.
Calibration definition files and calibration result files are stored in the folders as shown below.
Separate calibration definition folders are necessary for each calibration definition file.

	

Documents (My Documents)

Calibrate

Master

Calibration definition 1

Image

Calibration definition image file

Calibration definition file

Calibration definition file load error file

Calibration target instrument setting 
inquiry command file

Result

Backup
Calibration result file

Calibration target instrument setting backup file

Calibration definition 2

2. Installation Procedure
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3.	 Operation Flow
The following describes the operation flow.
The operation pattern is also shown on the screen of this software, so follow the instructions.

	

Start

Select a calibration definition file

Connect between the PC and the 
reference instrument

Connect between the PC and the 
calibration target instrument

Wire between the reference devices and the 
calibration target instrument

Execute calibration*

Disconnect the calibration target 
(Revert to the settings before calibration)

Disconnect the reference devices

End

Is rewiring required at the 
next calibration point?

No

No

Yes

Yes

Is the same 
calibration definition 

repeated?

Is all the calibration 
finished?

Yes

*:	 When calibration is executed, the output of the reference instruments is turned on.
	 This software starts loading the measured values for the calibration target instrument when the output of the 

reference instruments becomes stable and then a time of update count x update interval specified in the calibration 
definition file passes.

Before executing calibration, warm up the calibration target instrument and reference instruments.



7IM B8510UA-01EN 

4.	 Starting This Software
Double-click the Calibration Software icon on the desktop or click Calibration Software from the start 
menu.
The list of calibration definition files supplied with this software is displayed.

	

Exiting This Software
From the File menu in the menu bar, select Quit.
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5.	 Menu Bar
The menu bar of this software has the file, edit, option, and help functions.

File
This menu is used to exit the software.
From the File menu in the menu bar, select Quit.

	

Edit
This menu is used to set the text size or items displayed in the calibration point list.
From the Edit menu in the menu bar, select Option.
The option dialog box appears.

	

	

Select whether to continue or stop calibration when 
the calibrator trips 

Select the item to display during calibration

Set the displayed text size

Select whether to show a file name check dialog box 
when saving a calibration result

Tolerance
	 Tolerance obtained from ErrorStyle, ErrorParameter1, ErrorParameter2, and ErrorParameter3 

specified in the calibration definition file

Error ratio
	 Displays one of the following error ratios:

	 Ratio of error to generated value:
		   ((Measured value - Generated value) / Generated value) x 100 %
	 Ratio of error to generated value:

	 When the measured value is greater than generated value: 
		  ((Measured value - Generated value) / (Maximum tolerance - Generated value)) x 100 %
	 When the measured value is smaller than generated value: 
		  ((Measured value - Generated value) / (Generated value - Minimum tolerance)) x 100 %
	 Specify the tolerance in the calibration definition file.

Result
	 Displays the calibration result.

	 Blank: The error ratio is not exceeding the threshold.
	 Fail: The measured value is out of the tolerance range.
	 Warning: The ratio of error to tolerance is exceeding the threshold.
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File Name Check Dialog Box
	 The serial number of the calibration target instrument is used in the file names of calibration results, 

but if the serial number contains characters that cannot be used in file names, the number cannot be 
used as-is. As such, a file name check dialog box can be shown when you save a calibration result 
allowing you to select how the forbidden characters are to be removed.

		
	 If you click Yes, Save dialog boxes will be shown with the forbidden characters removed from the file 

names.
	 If you click No, Save dialog boxes will be shown without removing the forbidden characters. When a 

Save dialog box appears, correct the file name in the dialog box.

View
This menu is used to refresh the screen.
From the View menu in the menu bar, select Update.

	

Help
This menu is used to display the version information of this software.

5. Menu Bar
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6.	 Calibration for WT100, WT200, WT300, and 
WT300E Series

Loading Calibration Definition File
This software contains calibration definition files for the WT100, WT200, WT300, and WT300E series.
To create a unique calibration definition file, refer to "7. Creating Calibration Definition File".

1.	 Start this software.

2.	 From the displayed calibration definition files, select one suitable for the calibration target 
instrument and click Next.

				  

Model specified in the calibration definition file
Contents specified in the calibration definition file

File name

Drag the column border to change the display area

	 Instruments and cables required for calibration are displayed. Check if any items are missing.
	 Click Next.
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Connecting Reference Instruments
3.	 Confirm that the output of the reference instrument is turned off and connect between the PC and 

the reference instrument.

4.	 When the PC and the reference instrument are connected via USB
	 From the Serial number pull-down menu, select the serial number of the instrument to be used.
	 It may take a while before the serial number is shown in the pull-down menu.
	 For the LS3300 UNIT 2 or 3, the serial number of the connected instrument is set.

				  

	 If the serial number is not shown, check if the connection is correct or the reference instrument 
is turned on.

	 When the PC and reference instrument are connected via non-USB
	 Connect the PC to the reference instrument with the address specified in the calibration definition 

file. When it is successfully connected to the reference instrument, the serial number is shown.

Note
	 If the serial number is specified in the calibration definition file, that serial number is set.

5.	 Click Connect.
	 If the instrument is connected correctly, the Status column shows "Matched".

				  

	 One of the following statuses is shown according to the connection condition.
	 Matched: 	 The model of the connected reference instrument matches the model in the 

calibration definition file.
		  It also matches the serial number if the number is specified in the calibration 

definition file.
	 Unmatched: 	It does not match the model or serial number in the calibration definition file.
	 Missing: 	 The PC and the reference instrument cannot be connected to each other.

6. Calibration for WT100, WT200, WT300, and WT300E Series
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6.	 Click Next.
	 When both the 2560A and LS3300 are used, the 2560A or LS3300 connection window appears.
	 Repeat steps 3 to 6.
	 When all the reference instruments are successfully connected, the calibration target instrument 

connection window appears.

Connecting Calibration Target Instrument
7.	 Connect between the PC and the calibration target instrument.

8.	 From the Remote interface pull-down menu, select the remote interface to be used.

9.	 The setting items vary depending on the remote interface. Set each item according to the table 
below.
Remote interface Item Description
USB* Serial number The USB serial number of the connected instrument is 

shown in the pull-down menu.
GPIB Address Set the GPIB address.
ETHERNET* IP address Set the IP address.
RS-232 Port number Select a positive integer between 1 and 255.

Baud rate Select 1200bps, 2400bps, 4800bps, 9600bps, 
19200bps, 38400bps, 57600bps, or 115200bps.

Format 8Bit,NoParity,1StopBit
7Bit,EvenParity,1StopBit
7Bit,OddParity,1StopBit

Handshake Select NONE, XON/XOFF, or CTS-RTS.
Terminator Select CR+LF, or LF.

None - -
	 *: The WT100 and WT200 series do not support USB and ETHERNET.

Note
-	 When Remote interface is set to "None", the PC does not communicate with the calibration target 

instrument. Before executing calibration, manually change the settings for the calibration target 
instrument.

	 The settings cannot be reverted to the ones before calibration because setting data for the calibration 
target instrument cannot be backed up.

-	 The USB serial number for the WT100, WT200, WT300, and WT300E series is the same as the 
corresponding product serial number.

-	 Use "LF" for the GP-IB terminator for the WT100, WT200, WT300, and WT300E series.
-	 The instrument may not operate properly if the instrument is connected to the PC through converters 

(such as a GPIB to USB converter or RS-232 to USB converter). For more details, contact your nearest 
YOKOGAWA dealer.

-	 During calibration, insert and remove the communication cable according to the instructions on the 
screen.

	 If you do not follow the instructions, the instrument may not be detected or may operate improperly.

6. Calibration for WT100, WT200, WT300, and WT300E Series
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	 Window when Remote interface is set to USB

				  

10.	 When Remote interface is set to other than "None", click Connect. The Connect button changes 
to the Disconnect button.

	 If the instrument is connected correctly, the Status column shows "Matched".	

				  

	 One of the following statuses is shown according to the connection condition.
	 Matched: 	 It matches the model of the connected instrument and is equipped with necessary 

options.
	 Unmatched: 	It does not match the model of the connected instrument.
	 Missing: 	 It cannot connect to the instrument.

11.	 Enter the serial number of the calibration target instrument. When the PC is communicating with 
the calibration target instrument, the serial number is automatically entered.

	 If Remote interface is set to "None", manually enter the serial number.
	 For the WT100 and WT200 series, you can manually enter the serial number even when the PC 

is communicating with the calibration target instrument.

12.	 Click Next.
	 The setup for the device to be calibrated is backed up according to the query command in the 

setup backup query command file.

Note
The setup backup query command file is stored in the Documents > Calibrate > Master > Calibration 
definition folder.
A backup file of the setup for the device to be calibrated is saved in the Documents > Calibrate > Backup 
folder. The file is named as “the model of the device to be calibrated-serial number-date.txt.”
The setup backup file for the device to be calibrated is used after a calibration to return the setup of the 
device to what it was before the calibration.

6. Calibration for WT100, WT200, WT300, and WT300E Series
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Executing Calibration
13.	 The list of calibration points specified in the calibration definition file is displayed.
	 Select calibration points to execute. To automatically execute calibration for the selected points 

continuously, select the Continuous checkbox. To execute calibration for each point, deselect 
the Continuous checkbox.

			 

Drag the column border to change the display areaSelect calibration points to execute

Select to execute 
calibration for the 
selected points 
continuously

Items selected in Edit 
> Option in the menu 
bar

14.	 Click Execute.
	 The wiring diagram between the reference instrument and the calibration target instrument 

appears.

				  

	 Confirm that the output of the reference instrument is turned off and connect wiring between the 
reference instrument and the calibration target instrument.

	 When Remote interface is set to other than "None", go to the next page.
	 When Remote interface is set to "None", go to page 17.

6. Calibration for WT100, WT200, WT300, and WT300E Series
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When Remote Interface Is Set to Other Than None
15.	 Click OK.
	 Calibration starts.

				  

Measured value
Error ratio

Judgment result

	 One of the following judgment results is displayed.
	 Fail: 	 The measured value is out of the tolerance range.
	 Warning: 	 The ratio of error to tolerance is exceeding the threshold set in the Edit menu in the 

menu bar.
	 To cancel the calibration, click Abort. When the confirmation message appears, click OK. If the 

calibration is canceled, the calibration data collected so far will be lost.

16.	 At calibration points where the wiring needs to be changed, the calibration is halted, and a 
window prompting you to change the wiring appears. At this time, the output of the reference 
instrument is automatically turned off.

	 Change the wiring for the calibration point and click OK.

				  

6. Calibration for WT100, WT200, WT300, and WT300E Series
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17.	 After the calibration of all selected calibration points is completed, clicking Next will open a 
comment input screen.

	 Enter a comment and click Save.
	 The calibration result is saved in a CSV file.
	 The file location is My Documents > Calibrate > Result folder.
	 The file name is "Calibration target instrument model-Serial number-Calibration date (Year/

Month/Day/Hour/Minute/Second).csv".

				    Redo the calibration Save the file

Enter a comment
Name of the saved file

18.	 To exit the calibration, click Finish and Return.
	 A message dialog box appears for you to check if you execute the same calibration as the 

previous one for the same model.

19.	 If you click Yes, you will return to the calibration target instrument connection window.
	 If you click No, you will return to the calibration definition file list window.

Note
•	 If the calibration point is less than 1.000 mV AC and less than 0.3000 mA AC, this is outside the 

guaranteed accuracy range of the reference instrument LS330, and therefore, proper calibration cannot 
be performed.

•	 Clicking Finish and Return causes the setup of the device to be calibrated to what it was before the 
calibration according to the setup command in the setup backup file.

	 The setup backup file for the device to be calibrated is in the Documents > Calibrate > Backup folder.

6. Calibration for WT100, WT200, WT300, and WT300E Series
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When Remote Interface Is Set to None
15.	 Click OK.
	 A window appears for you to set the calibration target instrument for each calibration point.

				  

	 Set the calibration target instrument manually for the calibration point.

16.	 Click OUTPUT ON.
	 The list of calibration points is displayed, and the output of the reference instruments is turned 

on.

				    Enter the measured value of the calibration target instrument

17.	 Enter the measured value of the calibration target instrument and click OK.
	 A window appears for you to set the calibration target instrument for the next calibration point.

18.	 Perform the above step for each calibration point.

				  

The error ratio 
and judgment of 
the measurement 
result are 
displayed

The entered measured value is displayed

19.	 After the calibration of all selected calibration points is completed, clicking Next will open a 
comment input screen.

	 Perform step 17 and subsequent steps in "When Remote Interface Is Set to Other Than None".

6. Calibration for WT100, WT200, WT300, and WT300E Series
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Usage method of calibration result file (creation of test certificate)
Since the calibration result file is CSV format data, it can be imported into various application software. 
In addition, you can also use the macro file to use the measurement result file variously.
This software comes with a sample of Excel macros that create a test certificate using the calibration 
result data.

1.	 Open the Excel file "CertificateMaker.xlsm" in the Calibrate folder.

				  

Clear the Result sheet

Create a test certificate

Sheet where the test certificate is created
Sheet to which the calibration result is copied

Sheet written in English

2.	 Click the Clear button.

3.	 Open the calibration result file saved in Documents > Calibrate > Result folder.

4.	 Copy all the cells in the calibration result file to the Result sheet in CertificateMaker.xlsm.
	 Start copying from A1 cell.

5.	 Click the Make button in the Manual sheet.
	 The test certificate is created in the Certificate sheet.

				  

日付
DATE
モデル シリアル番号

MODEL SERIAL NO.

RANGE LEVEL RANGE LEVEL FREQUENCY PF TOLERANCE RESULT
15V 15V 60Hz 15.000V 14.970V ～ 15.030V 15.006V
30V 30V 60Hz 30.000V 29.940V ～ 30.060V 30.012V
60V 60V 60Hz 60.000V 59.880V ～ 60.120V 59.970V

150V 150V 60Hz 150.00V 149.70V ～ 150.30V 149.93V
150V 150V 60Hz 150.00V 149.70V ～ 150.30V 149.93V
150V 100V 1kHz 100.00V 99.60V ～ 100.40V 99.94V
300V 300V 60Hz 300.00V 299.40V ～ 300.60V 299.86V
600V 60V 60Hz 60.00V 59.34V ～ 60.66V 59.97V
600V 100V 60Hz 100.00V 99.30V ～ 100.70V 99.95V
600V 300V 60Hz 300.00V 299.10V ～ 300.90V 299.87V
600V 600V 60Hz 600.00V 598.80V ～ 601.20V 599.77V

5mA 5mA 60Hz 0.0050mA 0.0050mA ～ 0.0050mA 0.0050mA
10mA 10mA 60Hz 0.010mA 0.010mA ～ 0.010mA 0.010mA
10mA 10mA 1kHz 0.010mA 0.010mA ～ 0.010mA 0.010mA
20mA 20mA 60Hz 0.020mA 0.020mA ～ 0.020mA 0.020mA Warning

100mA 100mA 60Hz 0.10mA 0.10mA ～ 0.10mA 0.10mA
0.5A 500mA 60Hz 0.50mA 0.50mA ～ 0.50mA 0.50mA

1A 0.1A 60Hz 0.1000A 0.0989A ～ 0.1011A 0.1000A

成　　績　　表

WT310

TEST CERTIFICATE

CURRENTVOLTAGE

2018/06/14 12:13:57

GENERATED
VALUE

MEASURED
VALUE

6. Calibration for WT100, WT200, WT300, and WT300E Series
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7.	 Creating Calibration Definition File
A calibration definition file is a CSV format file that describes the calibration target instrument 
information, calibrator information, calibration point information, and judgment criteria. You can also set 
that a calibration result is automatically written to the file.
When this software is installed, a sample file for each calibration target instrument is installed.

Description of Calibration Definition File
Item Setting value

Specified in 
calibration 
definition file

A
dded to

the calibration 
result file

Format (format definition)
Version Version Format version of the calibration definition file. 0 or a positive 

integer. Current version: 0
ü –

Target Instrument (calibration target instrument definition) ü –
Model name Model Specify the calibration target model name. ü –
Optional 
feature

Option Specify the option code required for the calibration target 
instrument. Leave it blank to specify no value.
EX1, EX2(WT series)

ü –

Summary Contents Describe the contents of calibration displayed in the 
calibration pattern selection window.

ü –

Update 
interval

SampleRate Specify the measurement update interval. For the WT100 
and WT200 (excluding WT210 and WT230) series, this is 
fixed to 0.25 s.
0.1, 0.25, 0.5, 1, 2, 5

ü –

Update count SampleCount Specify the update count from when the output of the 
reference instruments becomes stable to when the 
measured data is imported.
Integer greater than or equal to 1.

ü –

Prepared 
image

ImagePath Enter the relative path (path based on the calibration 
definition file) of a instrument image required for calibration, 
which is displayed on the screen of this software. 

ü –

Serial number SerialNumber This is automatically entered as a calibration result. – ü
Calibration 
date

Date This is automatically entered as a calibration result. – ü

Reference Instruments (reference instrument definition)
Model name Model Specify the calibrator model name. This is optional. ü –

Output 
function

Function For the 2560A, specify the output function. V and A can 
be selected once each. VA indicates that both V and A are 
defined. For the LS3300, this column is ignored.
V, A, VA

ü –

Serial number SerialNo Enter the serial number of the calibrator to be used. For 
the LS3300, a blank indicates that the serial number is not 
specified, and IGNORE indicates that the calibrator is not 
used. The serial number must not be duplicated.

ü ü

Remote 
interface

RemoteInterface Specify the connection method.
USB, GPIB, Ethernet

ü –

Address Address Enter the GPIB address or IP address.
For the GPIB address, specify a value between 0 and 30.

ü –

Points (calibration point definition)
AC, DC ACDC Select AC or DC. This is required.

AC: Alternating current, DC: Direct current
ü –
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Item Setting value

Specified in 
calibration 
definition file

A
dded to

the calibration 
result file

Function Function Select the function each for the calibrator and the calibration 
target instrument. This is required.
V: Voltage
A: Current
1P2W: Single-phase power
1P3WT: Multi-phase power, Single-phase three-wire system 
(UNIT2 preferred)
1P3WS: Multi-phase power, Single-phase three-wire system 
(UNIT3 preferred)
3P3WT: Multi-phase power, Three-phase three-wire system 
(UNIT2 preferred)
3P3WS: Multi-phase power, Three-phase three-wire system 
(UNIT3 preferred)
3P4W: Three-phase four-wire system

ü –

Element Element Specify the element number of the calibration target 
instrument. The value must be a positive integer or "SIGMA".

ü –

Voltage Range VoltageRange Select the voltage range of the calibration target instrument. ü –
Level VoltageLevel Specify the calibration voltage level of the calibration 

target instrument. Can be set within the ratings of both the 
reference instrument and the calibration target instrument. 
Floating point number.

ü –

Current Range CurrentRange Select the current range of the calibration target instrument. 
To specify a current sensor, put EXT at the beginning.
1A, 500mA, EXT5V

ü –

Level CurrentLevel Specify the calibration current level of the calibration 
target instrument. Can be set within the ratings of both the 
reference instrument and the calibration target instrument. 
Floating point number.
1A, 500mA, 5V

ü –

Sensor ratio 
or scaling 
constant

SensorRatio Specify the sensor ratio or scaling constant of the calibration 
target instrument. Ignored when the current sensor will not 
be calibrated. When the unit is mV/A, it is treated as the 
sensor ratio. When the unit is A, it is treated as the scaling 
constant, calculating the sensor ratio from the EXT range.

ü –

Frequency Frequency Specify the AC frequency of the reference instrument. For 
the DC output, this is ignored. Floating point number.

ü –

Phase lead 
or lag

LeadLag Specify the lead or lag of the current phase. This is enabled 
for AC.
LEAD, LAG, none(LAG)

ü –

Power factor PowerFactor Specify the power factor. Floating point number between -1.0 
and 1.0. This is enabled for AC.

ü –

Measurement 
resolution

Resolution Specify the number of decimal places of the calibration result 
as resolution.
Integer greater than or equal to 0.

ü –

Auxiliary unit SiPrefix Auxiliary unit of the calibration result.
Select ' ' (none), k, m, or u.

ü –

Measurement 
unit

Unit Measurement unit of the calibration result.
Select ' ' V, A, W, var, or VA.

ü –

Measurement 
method

Item Specify the measurement method for the calibration target 
instrument.
Select RMS, MEAN, or DC.

ü –

Tolerance 
format*

ErrorStyle Specify the tolerance format. If this is blank, the description 
in the tolerance field is ignored and not judged.
ABSOLUTE, RELATIVE, PERCENT

ü –

Tolerance 
field 1*

ErrorParameter1 Specify a description according to the tolerance format. ü –

Tolerance 
field 2*

ErrorParameter2 Specify a description according to the tolerance format. ü –

Tolerance 
field 3*

ErrorParameter3 Specify a description according to the tolerance format. ü –

7. Creating Calibration Definition File
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Item Setting value
Specified in 
calibration 
definition file

A
dded to

the calibration 
result file

Wiring 
diagram

Image Path Specify the path of an image file displayed as a wiring 
diagram. Character string of the bitmap/jpg/pdf file name. 
This is optional.

ü –

Generated 
value

GeneratedValue The generated value is entered. – ü

Measured 
value

MeasuredValue The measured value of the calibration target instrument or 
the value eye-measured by the user is entered.

– ü

Absolute 
tolerance 
(lower limit)

MinTorerance The lower limit of the tolerance is entered.

Absolute 
tolerance 
(upper limit)

MaxTorerance The upper limit of the tolerance is entered.

Ratio of error 
to generated 
value

ErrorRatio1 With the maximum and minimum tolerance ±100 %, the error 
ratio of the measured value is entered.

– ü

Ratio of error 
to generated 
value

ErrorRatio2 The error ratio is entered.
((Measured value - Generated value) / Generated value) x 
100 %

– ü

Judgment Result The judgment result is entered based on the accuracy and 
the measured result.

– ü

Comments(user comment display field) – ü

*Specify the appropriate description according to the table below.
Definition description ErrorStyle ErrorParameter1 ErrorParameter2 ErrorParameter3
Define tolerance with an 
absolute value

ABSOLUTE Minimum tolerance
(absolute value)

Maximum tolerance
(absolute value)

Blank (ignored)

Define tolerance with a 
relative value

RELATIVE ± relative value Blank (ignored) Blank (ignored)

Define tolerance with 
accuracy

PERCENT % of Reading(%RS) % of Range(%FS) % of VA

7. Creating Calibration Definition File
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Description Method
Calibration target instrument definition header, reference instrument definition 
header, calibration point definition header

	 Put "#" at the beginning and the end. This is required.
	 # Format #
	 # Target Instrument #
	 # Reference Instruments #
	 # Points #
	 # Comments #
	 You cannot modify a single-byte space between # and a word and between words.

Format definition
	 Enter <Version> as the item name header.
	 Put the file version in the row under the header.

Calibration target instrument definition
	 Enter <Model>, <Option>, <Contents>, <SampleRate>, <SampleCount>, <ImagePath>, 

<SerialNumber>, and <Date> as the item name headers.
	 Put the information in the row under each header.
	 <SerialNumber>and <Date> are automatically filled out as a calibration result.

Reference instrument definition
	 Enter <Model>, <Function>, <SerialNo>, <Remote I/F>, and <Address> as the item name headers.
	 Put the information in the row under each header. This is required for each of the connected reference 

instruments.
- 	 When multiple LS3300 units are connected, specify them in the order of units with the serial 

numbers separated by ";". Set "IGNORE" for the serial number of a unit not used. If UNIT 1 is 
IGNORE, UNIT 2 and 3 are also set to IGNORE.

- 	 If you put "#" at the beginning of Model like "#LS3300", the description of this reference instrument 
is ignored. This is used to temporarily comment out.

Calibration point definition
	 Enter <ACDC>, <Function>, <Element>, <VoltageRange>, <VoltageLevel>, <CurrentRange>, 

<CurrentLevel>, <SensorRatio>, <Frequency>, <LeadLag>, <PowerFactor>, <Resolution>, <SiPrefix>, 
<Unit>, <Item>, <ErrorStyle>, <ErrorParameter1>, <ErrorParameter2>, <ErrorParameter3>, 
<Image>, <GeneratedValue>, <MeasuredValue>, <MinTolerance>, <MaxTolerance>, <ErrorRatio1>, 
<ErrorRatio2>, and <Result> as the item name headers.

	 Put the information in the row under each header. This is required for each calibration point.
At least one calibration point must to be defined.

	 <GeneratedValue>, <MeasuredValue>, <MinTolerance>, <MaxTolerance>, <ErrorRatio1>, 
<ErrorRatio2>, and <Result> are automatically filled out as a calibration result.

	 See the description example shown on the last page of this manual.
	 To change the settings for the calibration target instrument before executing calibration at a calibration 

point, insert a row above the calibration point and enter the command line following "#" at the left end. 
This is used to manually change the range of the calibration target instrument.

7. Creating Calibration Definition File
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Destination Folder of Calibration Definition File
Save the calibration definition file in Documents >Calibrate > Master > Calibration Definition folder.
If it is saved in a folder other than the above, it is not displayed on the calibration definition file load 
window.
Name the calibration definition file as “calibration definition folder name”.csv. For example, if the 
calibration definition folder name is “calib123,” save the file as “calib123.csv.”
If you want to create several calibration definition files, save them in separate calibration definition 
folders.

Setup Backup Query Command File
The setup backup query command file is used before a calibration to save setup information that will be 
changed by a calibration definition file. It is a text file containing setup query commands.
The results of the query made by the setup backup query command file are saved in the Backup folder. 
The saved file is used after a calibration to return the setup of the device to what it was before the 
calibration.
When you install this software, a sample file is installed for each device to be calibrated.
If you create a new file, save it in the Documents > Calibrate > Master > Calibration definition folder. 
The file name is calibration definition folder_Backup.txt. Add “_Backup.txt” after the calibration definition 
folder name.
For details on commands, see the manual for the device to be calibrated.

File Names
The names of various files are as follows:

Calibrate
Master

Calibration definition 1
Folder name 1:  User-defined string

Image
Calibration definition file
File name: <calibration definition folder name 1>.csv
Calibration definition file load error file
File name: <calibration definition folder name 1>_Error.txt
Calibration target instrument setting inquiry command file
File name: <calibration definition folder name 1>_Backup.txt

Calibration definition 2
Folder name 2:  User-defined string

Calibration definition file
File name: <calibration definition folder name 2>.csv
Calibration definition file load error file
File name: <calibration definition folder name 2>_Error.txt
Calibration target instrument setting inquiry command file
File name: <calibration definition folder name 1>_Backup.txtResult

Backup

Calibration result file
File name: the model of the device to be calibrated-serial number-calibration date.csv.

Calibration target instrument setting backup file
File name: the model of the device to be calibrated-serial number-calibration date.txt

Documents (My Documents)

7. Creating Calibration Definition File
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8.	 Calibration for Power Meters Other Than WT100, 
WT200, WT300, and WT300E Series

To execute calibration for power meters other than WT100, WT200, WT300, and WT300E series, create 
a calibration definition file appropriate for the calibration target instrument according to "6. Creating 
Calibration Definition File".
You cannot configure the settings for the calibration target instrument remotely from this software. Set 
the calibration target instrument for each calibration point.

Loading Calibration Definition File
Load the calibration definition file according to "6. Calibration for WT100, WT200, WT300, and WT300E 
Series".

Connecting Reference Instruments
Connect between the PC and the reference instruments according to "6. Calibration for WT100, WT200, 
WT300, and WT300E Series".

Connecting Calibration Target Instrument
1.	 Connect between the PC and the calibration target instrument and turn on the calibration target 

instrument.

2.	 From the Remote interface pull-down menu, select the remote interface to be used.

				  
3.	 The setting items vary depending on the remote interface. Set each item according to the table 

below.
Remote interface Item Description
USB Serial number Enter the USB serial number of the connected 

instrument.
GPIB Address Set the GPIB address.

Terminator Select CR+EOI, LF+EOI, CR, LF, or EOI.
ETHERNET IP address Set the IP address.
RS-232 Port number Select a positive integer between 1 and 255.

Baud rate Select 1200bps, 2400bps, 4800bps, 9600bps, 
19200bps, 38400bps, 57600bps, or 115200bps.

Format 8Bit,NoParity,1StopBit
7Bit,EvenParity,1StopBit
7Bit,OddParity,1StopBit
8Bit,OddParity,1StopBit
7Bit, NoParity, 1.5StopBit
8Bit, NoParity, 2StopBit.

Handshake Select NONE, XON/XOFF, or CTS-RTS.
Terminator Select CR+LF, CR, or LF.

None - -
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4.	 Enter the serial number of the calibration target instrument manually.

Note
Depending on the settings specified in chapter 5, “Menu Bar,” a file name check dialog box may appear when 
you save the calibration result. When a Save dialog box appears, correct the file name in the dialog box.

5.	 Click Next.

6.	 The list of calibration points specified in the calibration definition file is displayed.
	 Select calibration points to execute. To automatically execute calibration for the selected points 

continuously, select the Continuous checkbox. To execute calibration for each point, deselect 
the Continuous checkbox.

	

Select calibration points to execute Drag the column border to change the display area

Items selected in Edit 
> Option in the menu 
bar

Select to execute 
calibration for the 
selected points 
continuously

7.	 Click Execute.
	 The wiring diagram between the reference instrument and the calibration target instrument 

appears.

				  

	 Confirm that the output of the reference instrument is turned off and connect wiring between the 
reference instrument and the calibration target instrument.

8.	 Click OK.
	 A window appears for you to set the calibration target instrument for each calibration point.

				  
	 Set the calibration target instrument manually for the calibration point.

8. Calibration for Power Meters Other Than WT100, WT200, WT300, and WT300E Series
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9.	 Click OUTPUT ON.
	 The list of calibration points is displayed, and the output of the reference instruments is turned 

on.

				  

Enter the measured value of 
the measurement target device

10.	 Enter the measured value of the calibration target instrument and click OK.
	 A window appears for you to set the calibration target instrument for the next calibration point.

11.	 Perform the above step for each calibration point.

				  

The entered measured value is displayed

The error ratio and 
judgment of the 
measurement 
result are displayed

12.	 After the calibration of all selected calibration points is completed, clicking Next will open a 
comment input screen.

	 Save the calibration result according to "6. Calibration for WT100, WT200, WT300, and WT300E 
Series".

	 Enter a comment and click Save.
	 The calibration result is saved in a CSV file.
	 The file location is Documents > Calibrate > Result folder.
	 The file name is "Calibration target instrument model-Serial number-Calibration date (Year/

Month/Day/Hour/Minute/Second).csv".

Note
Depending on the settings specified in chapter 5, “Menu Bar,” a file name check dialog box may appear when 
you save the calibration result. When a Save dialog box appears, correct the file name in the dialog box. For 
details, see chapter 5, “Menu Bar.”
If you select the Do not show this message again check box, the file name check dialog box will no longer be 
displayed and the behavior selected at the time the dialog box is closed (the behavior corresponding to Yes 
or No) will be retained. The corresponding setting in chapter 5, “Menu Bar,” will also be changed.

13.	 To exit the calibration, click Finish and Return.
	 You will return to the calibration definition file list window.

Like the WT100, WT200, WT300, and WT300E series, you can create a test certificate using a 
calibration result file.

8. Calibration for Power Meters Other Than WT100, WT200, WT300, and WT300E Series
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9.	 Specifications

Item Description
Calibration function Outputs single-phase/three-phase power by specifying the voltage/

current level and phase.
DC Voltage Range Automatically selected according to the level (Refer to 

the separate table)
Level -1200.0 to 1200.0 V (2560A)

Current Range Automatically selected according to the level (Refer to 
the separate table)

Level -12.0 to 36.0 A (2560A)
Power Range Automatically selected according to the level

Voltage level -1200.0to 1200.0 V (2560A)
Current level -12.0 to 36.0 A (2560A)

AC Voltage Range Automatically selected according to the level (Refer to 
the separate table)

Level 0.0 to 1200.0 V(LS3300)
Frequency 40.0 to 1200.0 Hz (LS3300)

Current Range Automatically selected according to the level (Refer to 
the separate table)

Level 0.0 to 180.0 A (LS3300)
Frequency 40.0 to 1200.0 Hz (LS3300)
EXT 0.0 to 6.0000 V(LS3300)

Power Range Automatically selected according to the level
Voltage level 0.0 to 1200.0 V (LS3300)
Current level 0.0 to 60.0 A (LS3300)
Phase -180.000 to +359.999 °
Power factor Delay/advance -1.0 to 1.0
Frequency 40.0 to 1200.0 Hz (LS3300)

Reference instrument
DC Voltage/current 2560A 1 unit

Power 2560A 2 units
AC Voltage/current LS3300 1 unit

2 units (up to 120 A)
3 units (up to 180 A)

Power LS3300 1 unit (single-phase)
2 units (up to single-phase 120 A)
3 units (up to single-phase 180 A)
2 units (single-phase three-wire system or three-phase 
three-wire system)
3 units (three-phase four-wire system)

Calibration Target Instruments WT310E, WT310EH, WT332E, WT333E, WT310, WT310HC, WT332, 
WT333, 760401 (WT210), 760502 (WT230), 760503 (WT230), 253401 
(WT110), 25345 (WT110E), 253421 (WT200), 253502 (WT130), 
253503 (WT130)

Remote communication interface/protocol
Reference instrument GPIB, USB/USB-TMC, ETHERNET/VXI-11
Calibration target instrument GPIB, USB/USB-TMC, ETHERNET/VXI-11, RS-232C

Other functions
Calibration target instrument setup 
save/restore

Saves and restores calibration target settings

Calibration point script management Lists, overviews, and selects calibration points
Calibration result management Lists and overview of the calibration results
Directory creation Creates a directory each for calibration target instrument setup, 

calibration point script management, and calibration result management
Multiple launch prevention Prevents multiple calibration software programs from starting

Operating environment
OS Windows 8.1, Windows 10, Windows 11
Language English, Japanese
.NET Framework 4.8 (included with this software)
YKMUSB driver Windows 8.1, Windows 10 (Device Guard disabled):	1.0.4.2

Windows 10 (Device Guard enabled), Windows 11:	 2.0.0.0 and later
TMCTL library 7.0.0.0

File format
Calibration definition file CSV format file (comma-separated)
Calibration result file CSV format file (comma-separated)
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AC Voltage level and Selected voltage range(LS3300)
Setting level Selected range
0.00000 V to 1.20000 V 1 V
1.2001 V to 12.0000 V 10 V
12.0001 V to 36.0000 V 30 V
36.001 V to 120.000 V 100 V
120.001 V to 360.000 V 300 V
360.01 V to 1200.00 V 1000 V

AC Current level and supported current range (LS3300)
Setting level Selected range
0.00000 mA to 36.0000 mA 30 mA
36.001 mA to 120.000 mA 100 mA
0.12001 A to 1.20000 A 1 A
1.2001 A to 12.0000 A 10 A
12.0001 A to 60.0000 A 50 A
60.001 A to 120.000 A 100 A
120.001 A to 180.000 A 150 A

Current sensor level and supported current sensor range for LS3300
Setting level Selected range
0.00 mV to 600.00 mV 500 mV
0.6001 V to 6.0000 V 5 V

DC Voltage level and supported voltage range (2560A)
Setting level Selected range
–120.000 mV to –0.000 mV
0.000 mV to 120.000 mV

100 mV

–1.20000 V to –0.12001 V
0.12001 V to 1.20000 V

1 V

–12.0000 V to –1.2001 V
1.2001 V to 12.0000 V

10 V

–120.000 V to –12.001 V
12.001 V to 120.000 V

100 V

–1200.00 V to –120.01 V
120.01 V to 1200.00 V

1000 V

DC Current level and supported current range (2560A)
Setting level Selected range
–120.000 µA to –0.000 µA
0.000 µA to 120.000 µA

100 µA

–1.20000 mA to –0.12001 mA
0.12001 mA to 1.20000 mA

1 mA

–12.0000 mA to –1.2001 mA
1.2001 mA to 12.0000 mA

10 mA

–120.000 A to –12.001 mA
12.001 mA to 120.000 A

100 mA

–1.20000 A to –0.12001 A
0.12001 A to 1.20000 A

1 A

–12.0000 A to –1.2001 A
1.2001 A to 12.0000 A

10 A

–36.0000 A to –12.0001 A
12.0001 A to 36.0000 A

30 A

9. Specifications



Sample of Calibration Definition File

# Target Instrument #
<Model> <Option> <Contents> <Rate> <Count> <ImagePath> <SerialNumber> <Date>

WT310 EX1
WT310 EX1
Sample

0.25 2
Image/Preparation
_AC_DC_EX.png

# Reference Instruments #
<Model> <Function><SerialNumber> <RemoteInterface> <Address>
LS3300 USB
2560A V USB
2560A A USB
# Points #
<ACDC> <Function> <Element> <VoltageRange> <VoltageLevel> <CurrentRange> <CurrentLevel> <SensorRatio> <Frequency> <PowerFactorDirection> <PowerFactorValue> <Resolution> <SiPrefix> <Unit> <Item> <ErrorStyle> <ErrorParameter1> <ErrorParameter2> <ImagePath> <GeneratedValue> <MeasuredValue> <MinTolerance> <MaxTolerance> <ErrorRatio1> <ErrorRatio2> <Result>
AC V 1 15V 15V 60Hz 3 V RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC V 1 30V 30V 60Hz 3 V RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC V 1 60V 60V 60Hz 3 V RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC V 1 150V 150V 60Hz 2 V RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC V 1 150V 150V 60Hz 2 V MEAN %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC V 1 150V 100V 1kHz 2 V RMS %RS%FS 0.10% 0.20% Image/WT310_VCX_LS3300_VCX.png
AC V 1 300V 300V 60Hz 2 V RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC V 1 600V 60V 60Hz 2 V RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC V 1 600V 100V 60Hz 2 V RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC V 1 600V 300V 60Hz 2 V RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC V 1 600V 600V 60Hz 2 V RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 5mA 5mA 60Hz 4 m A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 10mA 10mA 60Hz 3 m A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 10mA 10mA 1kHz 3 m A RMS %RS%FS 0.10% 0.20% Image/WT310_VCX_LS3300_VCX.png
AC A 1 20mA 20mA 60Hz 3 m A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 100mA 100mA 60Hz 2 m A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 0.5A 500mA 60Hz 2 m A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 1A 0.1A 60Hz 4 A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 1A 0.2A 60Hz 4 A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 1A 0.6A 60Hz 4 A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 1A 1A 60Hz 4 A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 1A 1A 1kHz 4 A RMS %RS%FS 0.10% 0.20% Image/WT310_VCX_LS3300_VCX.png
AC A 1 2A 2A 60Hz 4 A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 5A 5A 60Hz 4 A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 5A 5A 1kHz 4 A RMS %RS%FS 0.10% 0.20% Image/WT310_VCX_LS3300_VCX.png
AC A 1 10A 10A 60Hz 3 A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 20A 20A 60Hz 3 A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC A 1 EXT2.5V 2V 10mV/A 60Hz 2 A RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 15V 15V 1A 1A 60Hz 1 3 W RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 30V 30V 1A 1A 60Hz 1 3 W RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 60V 60V 1A 1A 60Hz 1 3 W RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 150V 150V 1A 1A 60Hz 1 2 W RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 150V 100V 1A 1A 1kHz 1 2 W RMS %RS%FS 0.10% 0.20% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 300V 300V 1A 1A 60Hz 1 2 W RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 600V 60V 1A 1A 60Hz 1 2 W RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 600V 100V 1A 1A 60Hz 1 2 W RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 600V 600V 1A 1A 60Hz 1 2 W RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 15V 10V 5A 5A 60Hz LEAD 0 3 W RMS %VA 0.20% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 15V 10V 5A 5A 60Hz LAG 0 3 W RMS %VA 0.20% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 150V 100V 5mA 5mA 60Hz 1 2 m W RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png
AC 1P2W 1 150V 100V 10mA 10mA 60Hz 1 4 W RMS %RS%FS 0.10% 0.10% Image/WT310_VCX_LS3300_VCX.png

# Format #
<Version>

0
Calibration target device definition header

Calibration target device definition

Calibrator definition header

Calibrator definition

Calibration point definition header

Calibration point definition

Format definition header
Format definition


	Preface
	Safety Precautions
	Contents
	1.	Overview of This Software
	2.	Installation Procedure
	3.	Operation Flow
	4.	Starting This Software
	5.	Menu Bar
	6.	Calibration for WT100, WT200, WT300, and WT300E Series
	7.	Creating Calibration Definition File
	8.	Calibration for Power Meters Other Than WT100, WT200, WT300, and WT300E Series
	9.	Specifications
	Sample of Calibration Definition File

